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Triphenyl phosphate-induced pericardial edema in zebrafish 
embryos is dependent on the ionic strength of exposure media

Jenna Wieganda, Sarah Avila-Barnarda, Charvita Nemarugommulaa, David Lyonsa, Sharon 
Zhangb, Heather M. Stapletonb, David C. Volzb,*

aDepartment of Environmental Sciences, University of California, Riverside, CA 92521, United 
States

bDivision of Environmental Sciences and Policy, Duke University, Durham, NC 27708, United 
States

Abstract

Pericardial edema is commonly observed in zebrafish embryo-based chemical toxicity screens, 

and a mechanism underlying edema may be disruption of embryonic osmoregulation. Therefore, 

the objective of this study was to identify whether triphenyl phosphate (TPHP) – a widely 

used aryl phosphate ester-based flame retardant – induces pericardial edema via impacts 

on osmoregulation within embryonic zebrafish. In addition to an increase in TPHP-induced 

microridges in the embryonic yolk sac epithelium, an increase in ionic strength of exposure 

media exacerbated TPHP-induced pericardial edema when embryos were exposed from 24 to 72 

h post-fertilization (hpf). However, there was no difference in embryonic sodium concentrations 

in situ within TPHP-exposed embryos relative to embryos exposed to vehicle (0.1% DMSO) from 

24 to 72 hpf. Interestingly, increasing the osmolarity of exposure media with mannitol (an osmotic 

diuretic which mitigates TPHP-induced pericardial edema) and increasing the ionic strength of the 

exposure media (which exacerbates TPHP-induced pericardial edema) did not affect embryonic 

doses of TPHP, suggesting that TPHP uptake was not altered under these varying experimental 

conditions. Overall, our findings suggest that TPHP-induced pericardial edema within zebrafish 

embryos is dependent on the ionic strength of exposure media, underscoring the importance 

of further standardization of exposure media and embryo rearing protocols in zebrafish-based 

chemical toxicity screening assays.

This is an open access article under the CC BY-NC-ND license (http://creativecommons.org/licenses/by-nc-nd/4.0/).
*Corresponding author. david.volz@ucr.edu (D.C. Volz). 
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1. Introduction

Pericardial edema – or fluid accumulation surrounding the developing heart – is an abnormal 

phenotype that is commonly observed across different species of fish embryos following 

exposure to a wide range of structurally diverse chemicals (Duan et al., 2013; Hermsen 

et al., 2017; Hill et al., 2004; McCollum et al., 2017; McGruer et al., 2021; Yozzo et al., 

2013; Yozzo et al., 2013). Depending on the magnitude and severity, pericardial edema has 

the potential to interfere with normal developmental landmarks, leading to abnormalities 

such as cardiac looping defects, bradycardia, and kidney malformations (Hill et al., 2004; 

Isales et al., 2015; McGee et al., 2012; Mitchell et al., 2019; K.L. Yozzo et al., 2013). 

In zebrafish embryos, prior studies have suggested that edema may be caused by kidney 

failure, circulatory failure, ionic imbalance, and permeability defects (Hill et al., 2004). 

Prior studies have hypothesized that edema may be a stress response that is not linked to 

any underlying mechanisms, and may be reversed if the severity is low (Brotzmann et al., 

2022; Von Hellfeld et al., 2020). The mechanisms underlying edema have been extensively 

studied within mammalian models and humans but, within the published literature specific 

to fish, edema is often reported as an abnormal phenotype/endpoint in the absence of 

mechanistic investigations. Pericardial edema and yolk sac edema are two of the most 

documented edema phenotypes due to the ability and ease that both endpoints can be 

measured and analyzed using brightfield microscopy (Narumanchi et al., 2021). Despite 

the ease of analysis and widespread use of these endpoints, pericardial edema and yolk 

sac edema are often considered non-specific phenotypes due to the lack of knowledge of 

underlying mechanisms causing edema formation (Narumanchi et al., 2021).

Zebrafish have emerged as a model teleost species to understand how embryonic and adult 

fish utilize osmoregulation to maintain homeostasis (Evans, 2011; Fridman, 2020; Pung 

Hwang et al., 2011; Pung Hwang and Chou, 2013; Kwong et al., 2014). As zebrafish 

gills continue to develop a capacity for O2 consumption until approximately 14 d post-

fertilization (dpf) (Rombough, 2007), aquaporins and epidermal ionocytes play a critical role 

in maintaining homeostasis within the developing embryos and larvae (Guh et al., 2015a). 

Within freshwater species, there are five types of ionocytes – KS (Potassium-Sodium 

pump), SLC (Sodium, Potassium, Chlorine, Bicarbonate pump), NCC (Sodium, Chlorine, 

Bicarbonate pump), NaRC (Calcium, Sodium, Potassium pump), and HR (Bicarbonate, 

sodium, hydrogen, carbon dioxide, ammonia, chlorine pump) (Guh et al., 2015b) – that 

regulate uptake of potassium, sodium, chlorine, bicarbonate, hydrogen, carbon dioxide 

and ammonia through aquaporins which, in turn, regulate water exchange between the 

embryo and surrounding aqueous environment (Kwong and Perry, 2015). Within embryonic 

zebrafish, the skin is the primary site of osmoregulation prior to gill-specific localization 

of ionocytes and aquaporins at approximately 14 dpf (Guh et al., 2015a). The skin of 

embryonic zebrafish also includes keratinocytes with distinct cell borders (Li et al., 2011), 
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and ionocytes and aquaporins are localized throughout the epidermal layer along these cell 

borders (Li et al., 2011).

Freshwater fish are dependent on the skin, kidney, intestinal tract, and gills to maintain 

homeostasis as a result of being constantly surrounded by water that is necessary for 

survival. The skin serves as a barrier for water and ions, while the kidney excretes water 

and organic waste (Serluca et al., 2002). Within zebrafish, these systems are critical within 

early life-stages since embryos rely on oxygen diffusion from the surrounding water in 

order to survive (Pelster and Burggren, 1996). During development, two separate water 

permeability barriers – one surrounding the embryonic body and one surrounding the yolk 

sac (Hagedorn et al., 1998) – allow embryos to regulate water uptake in the absence of a 

chorion in embryonic zebrafish, albeit the chorion may play a large role in regulating water 

uptake in other teleosts due to species-specific anatomical differences in the embryonic 

chorion (Hill et al., 2004). Interestingly, prior studies have demonstrated that impaired 

maintenance of the barrier surrounding the embryonic body results in edema (Hill et al., 

2004). The zebrafish embryonic yolk sac is made up of proteins (mostly vitellogenin) (Ge et 

al., 2017; Link et al., 2006) and lipids (cholesterol, phosphatidylcholine, and triglycerides), 

albeit the yolk sac composition is variable across teleost species (Link et al., 2006). The 

yolk can bioaccumulate toxins from waterborne exposures (Chen et al., 2015; Choi et al., 

2016; Dolgova et al., 2016; Souder and Gorelick, 2017), with uptake involving passive or 

active transport across the yolk sac epithelium (Sant and Timme-Laragy, 2018). The yolk 

sac epithelium contains a majority of ionocytes found in developing embryos, but there is 

little information about the function of epidermal ionocytes as well as the susceptibility 

of epidermal ionocytes to environmental chemicals (Kwong et al., 2016; Sant and Timme-

Laragy, 2018). The yolk sac is metabolically active (Cindrova-Davies et al., 2017) and, due 

to its ability to bioaccumulate hydrophobic environmental chemicals, may alter the normal 

trajectory of the developing embryo (Sant and Timme-Laragy, 2018).

One of the largest fields that utilizes pericardial edema and yolk sac edema as endpoints 

within fish embryos is toxicology. One paper compiled all of the studies that utilized 

zebrafish as a model for toxicology and listed all chemicals that caused abnormal 

phenotypes, including pericardial edema and yolk sac edema, up to 2011 (Mccollum 

et al., 2011). At the time of publication, 22 chemicals caused yolk sac edema and 35 

chemicals caused pericardial edema within zebrafish embryos, making these the most 

observed phenotypes (Mccollum et al., 2011). Since 2011, numerous labs around the world 

have identified a multitude of chemicals that induce pericardial edema and/or yolk sac 

edema. For example, our recent study found that pericardial edema was associated with 

elevated epidermal ionocytes within zebrafish embryos following a 24- to 72-hpf exposure 

to triphenyl phosphate (TPHP), an aryl phosphate ester-based flame retardant and plasticizer 

(Wiegand et al., 2022). Moreover, we found that co-exposure of embryos to mannitol 

(an osmotic diuretic) blocked TPHP-induced pericardial edema and effects on ionocyte 

abundance, whereas knockdown of ATPase1a1.4 – an abundant Na+/K+-ATPase localized 

to epidermal ionocytes – mitigated TPHP-induced effects on ionocyte abundance but not 

pericardial edema. Overall, our study suggested that TPHP-induced toxicity during early 

stages of development may potentially be driven by impacts on the osmoregulatory system 

within embryonic zebrafish (Wiegand et al., 2022).
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The objective of this study was to identify whether TPHP impacts osmoregulation within 

embryonic zebrafish. To accomplish this objective, we first utilized a fluorescent, sodium 

ion indicator dye and automated image acquisition/analysis protocols to quantify relative 

sodium concentrations in situ. Second, we utilized analytical chemistry to determine if the 

presence of mannitol or varying ionic strength of the surrounding exposure media affected 

TPHP uptake into the developing embryo. Third, we relied on ion chromatography and 

inductively coupled plasma optical emission spectrometry (ICP-OES) to 1) quantify the 

concentrations of fluoride, chloride, nitrite, bromide, nitrate, phosphate, sulfate, sodium, 

calcium, potassium, and magnesium in different media used for embryo exposures and 

2) determine how varying ion concentrations impacted embryonic phenotypes. Finally, we 

utilized scanning electron microscopy to determine whether TPHP altered the morphology 

and/or organization of the yolk sac epithelium, as we previously found that the majority of 

ATPase1a1-positive ionocytes were localized to the yolk sac epithelium.

2. Materials and methods

2.1. Animals

Using previously described procedures (Mitchell et al., 2018), wild-type adult (strain 5D) 

zebrafish were maintained and bred on a recirculating system according to an Institutional 

Animal Care and Use Committee-approved animal use protocol (#20210027) at the 

University of California, Riverside.

2.2. Chemicals

TPHP (99.5% purity) and D-mannitol (>98% purity) were purchased from ChemService, 

Inc. (West Chester, PA, USA) and Bio-Techne Corp. (Minneapolis, MN, USA), respectively. 

To prepare stock solutions, TPHP was dissolved in liquid chromatography-grade dimethyl 

sulfoxide (DMSO) and stored at room temperature in 2-mL glass amber vials with 

polytetrafluoroethylene-lined caps. To prepare working solutions, stock solutions of TPHP 

were spiked into water from our recirculating system (pH and conductivity of ~7–8 and 

~900–1000 μS, respectively), resulting in 0.1% DMSO within all vehicle control and TPHP 

treatments. D-mannitol solutions were freshly prepared by dissolving powder into water 

from our recirculating system and then immediately used for exposures.

2.3. TPHP exposures

Immediately after spawning, fertilized eggs were collected and incubated in groups of 

approximately 50 per 100 × 15 mm polystyrene petri dish until 24 h post-fertilization (hpf) 

within a light- and temperature-controlled incubator. Working solutions of vehicle (0.1% 

DMSO) or TPHP (2.5 μM, 5 μM, and 10 μM) were prepared as described above. Vehicle 

or TPHP solutions (10 mL) were added to 100 × 15 mm polystyrene petri dishes and viable 

embryos were then transferred to dishes, resulting in 30 initial embryos per dish (three 

replicate dishes per treatment). Embryos were then exposed to vehicle or TPHP from 24 to 

72 hpf. All dishes were covered with a lid and incubated under a 14-h:10-h light-dark cycle 

at 28 °C until 72 hpf. At 72 hpf, embryos were either 1) fixed overnight at 4 °C in 4% 

paraformaldehyde in 1X phosphate buffered saline (PBS), transferred to 1X PBS, and stored 
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at 4 °C for no longer than one month until imaging or 2) immediately stained and analyzed 

for embryonic sodium concentrations as described below.

2.4. Quantification of embryonic sodium concentrations

At 72 hpf, embryos were stained with a fluorescent sodium indicator dye (CoroNa Green 

AM, Invitrogen, Waltham, MA, USA) to quantify embryonic sodium concentrations in situ. 
At 72 hpf, the embryos were rinsed three times with reverse osmosis (RO) water and 

then placed in a working solution containing RO water, 20% Pluronic F-127 (Invitrogen, 

Waltham, MA, USA), and 10 μM CoroNa Green AM for 1.5 h. The working solution was 

then aspirated, and embryos were washed with RO water three times for 5 min each. Finally, 

embryos were immobilized with 100 mg/L MS-222 for 3 min, transferred into 96-well 

plates, and imaged under transmitted light and a FITC filter on our ImageXpress Micro 

XLS Widefield High-Content Screening System within MetaXpress 6.0.3.1658 (Molecular 

Devices, Sunnyvale, CA, USA). Body length, pericardial area, and yolk sac area were 

manually quantified within MetaXpress using images captured under transmitted light, 

whereas total area of sodium-derived fluorescence in the head, trunk and yolk sac was 

quantified with a custom module within MetaXpress using images captured under a FITC 

filter.

2.5. Embryo media experiments

Different concentrations (0.5X, 1X and 2X) of embryo media (EM) were created by diluting 

a stock concentration of 60X EM within RO water. 60X EM was made in-house by 

dissolving 17.2 g NaCl, 0.76 g KCl, 2.9 g CaCl2·2H20, and 4.9 g MgSO4·7H20 into 1 L of 

RO water, and then autoclaving the final solution prior to long-term storage at 4 °C (Brand et 

al., 2002). Varying concentrations of EM were used for TPHP exposures by spiking DMSO 

or TPHP into 0.5X, 1X or 2X EM, resulting in a final concentration of either 0.1% DMSO 

or 5 μM TPHP. Immediately after spawning, fertilized eggs were collected and incubated in 

groups of approximately 50 per 100 × 15 mm polystyrene petri dish until 24 hpf within a 

light- and temperature-controlled incubator. Working solutions of vehicle (0.1% DMSO) or 

5 μM TPHP in EM (0.5X, 1X or 2X) were prepared as described above. Vehicle or TPHP 

solutions (10 mL) were added to 100 × 15 mm polystyrene petri dishes and viable embryos 

were then transferred to dishes, resulting in 30 initial embryos per dish (three replicate 

dishes per treatment). Embryos were then exposed to vehicle or TPHP from 24 to 72 hpf. 

All dishes were covered with a lid and incubated under a 14-h:10-h light-dark cycle at 28 °C 

until 72 hpf. At 72 hpf, all embryos were analyzed as described above.

2.6. EM ingredient experiments

To determine if one of the EM ingredients was necessary for TPHP-induced pericardial 

edema, exposures of TPHP were performed in four different solutions containing individual 

ingredients of 2X EM. Four different solutions were prepared in RO water: 10 mM NaCl, 

0.17 mM KCl, 0.66 mM CaCl2·2H20, or 0.66 mM MgSO4·7H20. Each of these solutions 

were then spiked with DMSO or TPHP, resulting in a final concentration of either 0.1% 

DMSO or 5 μM TPHP. Embryos were then exposed from 24 to 72 hpf as described above. 

At 72 hpf, all embryos were analyzed as described above.
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2.7. Quantification of embryonic doses of TPHP and DPHP

Embryonic doses of TPHP and diphenyl phosphate (DPHP, the primary metabolite of 

TPHP within mammals) were quantified following exposure to TPHP from 24 to 72 hpf 

in RO water, system water, or 2X EM as described above. For the first experiment, 24-hpf 

embryos were transferred to 100 × 15 mm polystyrene petri dishes (30 embryos per dish; 

four replicate dishes per treatment) containing either system water and 0.1% DMSO, 5 

μM TPHP, 250 mM D-Mannitol, or 5 μM TPHP + 250 mM D-Mannitol. For the second 

experiment, 24-hpf embryos were transferred to 100 × 15 mm polystyrene Petri dishes (30 

embryos per dish; four replicate dishes per treatment) containing either 1) RO water + 0.1% 

DMSO or 5 μM TPHP, or 1) 2X EM + 0.1% DMSO or 5 μM TPHP. All embryos were 

incubated until 72 hpf. For each replicate group (4 groups per treatment), ~30 embryos 

were placed into a 2-mL cryovial, immediately snap-frozen in liquid nitrogen, and stored 

at −80 °C. Prior to extraction, samples were spiked with deuterated TPHP (d15-TPHP) and 

deuterated DPHP (d10-DPHP). Analytes were extracted and quantified similar to previously 

published methods (Mitchell et al., 2018). Method detection limits (MDLs) were set as three 

times the standard deviation of lab blanks. The MDLs for DPHP and TPHP were 0.86 ng 

and 1.19 ng, respectively, for the first experiment, and 0.05 ng and 0.03 ng, respectively, for 

the second experiment.

2.8. Ion chromatography and ICP-OES

To determine the concentration of ions within water used in our experiments, 10 mL 

samples of RO, system water, 0.5X EM, 1X EM, and 2X EM were analyzed within UCR’s 

Environmental Science Research Laboratory. Anions of interest were analyzed using a 

Dionex AQUION (Sunnyvale, CA) model ion chromatograph (IC) fitted with a conductivity 

cell detector, a 10-μL sample injection loop, Ion Pac AG14 (4x80 mm), AS14 (4x250 

mm) guard and analytical columns maintained at 30 °C, DRS-600 (4 mm) self-regenerating 

suppressor, and DV40 autosampler. The resin composition was ethylvinylbenzene cross-

linked with divinylbenzene. The column specifications were the following: 9-μm particle 

size, 55% substrate crosslinking, anion exchange capacity of 65 μeq, alkyl quaternary 

ammonium ion exchange group, and medium-high hydrophobicity. Calibration standards 

were diluted from certified stock solutions using deionized water prepared via a Labconco 

WaterPro DS system (Kansas City, MO). Eluent was prepared using this deionized water 

with the following concentration: 3.5 mM Na2CO3/1.0 mM NaHCO3. All glassware was 

washed using this deionized water. Anions were calibrated using concentrations ranging 

from 0.01 to 1000 ppm, with a limit of detection (LOD) determined using the equation LOD 

= (3.3 × SDy-intercept)/slope. Verification of calibration efficacy was conducted by analysis 

of a certified multi-anion reference standard, “VeriSpec Mixed Anion Standard 7”, yielding 

percent recoveries from 91% to 99% for all seven anions.

Cations were analyzed utilizing an Optima 7300 DV Model Inductively Coupled Plasma 

– Optical Emission Spectrometer (ICP-OES, Perkin-Elmer, Waltham, MA) and using an 

Elemental Scientific 4DXC autosampler (Omaha, NE). Samples and standards were pumped 

into a nebulization spray chamber at a rate of 0.80 mL per minute. These aerosolized 

droplets of 10 μm in diameter were then drawn into the argon plasma via a gas pressure 

of 0.5 L per min. The carrier liquid was 1% trace metal grade nitric acid (HNO3), and 
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a mixing T provided an inflow of 2.5 ppm Yttrium to serve as an internal standard. The 

argon plasma was generated using a gas flow rate of 14 L per min and a radio frequency 

inducement of 1350 W. Auxiliary gas flow was set to 0.2 L per min. Calibration standards 

were diluted from stock solutions certified by Spex, using deionized water prepared via 

a Labconco WaterPro DS system (Kansas City, MO) and trace metal grade nitric acid. 

Polypropylene flasks were used for all liquid preparations. Cations were calibrated using 

concentration ranging from 0.01 to 1000 ppm, with limit of detection (LOD) determined 

using the equation LOD = (3.3 × SDy-intercept)/slope. Verification of calibration efficacy was 

conducted by analysis of a certified multi-anion reference standard (VWR, Radnor, PA), 

yielding percent recoveries ranging from 89% to 99% for all four cations.

2.9. Scanning electron microscopy

To determine if TPHP induced alterations to the yolk sac epithelium, a Hitachi Tabletop 

TM4000Plus Scanning Electron Microscope (SEM) was utilized to scan five independent 

locations on the yolk sac of each embryo. Prior to imaging, exposures were performed 

from 24 to 72 hpf within RO water, system water, or 2X EM containing 0.1% DMSO, 

5 μM TPHP, 250 mM D-Mannitol, or 5 μM TPHP + 250 mM D-Mannitol. At 72 hpf, 

all embryos were fixed within 4% PFA as described above. Immediately before imaging, 

fixed embryos were flash frozen within a liquid nitrogen bath. Five different locations of 

the yolk sac of frozen embryos were then imaged using the following magnification and 

settings: 10 KV, setting 4, VSE, 2,000 X. Images were then analyzed within ImageJ (Version 

1.8.0_172) using the following steps: 1) File → Open → Chose photo for analysis; 2) 

Choose *straight* line button on the toolbar and measure one side of the well to the other. 

Then chose Analyze → Set Scale (keep distance listed in pixels the same, make known 

distance 3, keep the pixel aspect ratio the same, Unit length is mm, and click the checkbox 

next to global); 3) Image → Adjust → Threshold (set first box to 0 and second box to 35) 

→ click apply; 4) Analyze → Analyze particles (make sure the box next to summary is 

clicked); and 5) The number under total area provides the total area of microridges in the 

image, record and repeat steps.

2.10. Statistical analysis

For all data generated within this study, a general linear model (GLM) analysis of variance 

(ANOVA) (α = 0.05) and Tukey-based multiple comparisons were performed using SPSS 

Statistics 24.

3. Results

3.1. TPHP does not affect embryonic sodium concentrations in situ

Relative to embryos exposed to vehicle (0.1% DMSO) from 24 to 72 hpf, exposure 

to TPHP (2.5 μM, 5 μM and 10 μM) from 24 to 72 hpf did not significantly affect 

sodium concentrations within the head, yolk sac, or trunk of embryonic zebrafish (Fig. 1). 

Pericardial area and yolk sac area were also quantified and, consistent with our prior studies, 

we found no significant differences in yolk sac area whereas TPHP increased pericardial 

area in a concentration-dependent manner (Fig. 1).
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3.2. TPHP-induced pericardial edema is dependent on ionic strength of exposure media

To better characterize the ionic composition of exposure media used within this study, we 

first quantified the concentration (in ppm) of fluoride, chloride, nitrite, bromide, nitrate, 

phosphate, sulfate, sodium, calcium, potassium, or magnesium in RO Water, System Water, 

0.5X EM, 1X EM, and 2X EM. Interestingly, the concentration of chloride increased as a 

function of EM strength and accounted for the majority of ions present within 0.5X, 1X, and 

2X EM (Fig. 2; Figure S1). Indeed, the concentration of chloride within 2X EM was 3X 

higher than the next highest ion (sodium) (Fig. 2), a finding that was not surprising since 

three out of the four salts used to make EM contain chloride.

Embryos were exposed to 5 μM TPHP in different exposure media (RO Water, 0.5X EM, 1X 

EM, or 2X EM) from 24 to 72 hpf to determine if an increase in ionic strength of exposure 

media altered TPHP-induced pericardial edema. While TPHP decreased body length across 

all exposure media, TPHP did not affect yolk sac area within any of exposure media (Fig. 3). 

However, we found that, even in the presence of TPHP, pericardial area was not significantly 

different from water or vehicle controls when exposed within RO water or 0.5X EM (Fig. 3). 

However, when embryos were exposed to TPHP within 1X or 2X EM, pericardial area was 

significantly higher relative to water and vehicle controls, similar to what we have observed 

in this study and our prior studies using system water (Fig. 3). Interestingly, similar to our 

prior findings in system water, D-Mannitol completely mitigated TPHP-induced pericardial 

edema within co-exposed within 1X or 2X EM (Fig. 3).

To determine if a specific salt within EM was required for TPHP-induced pericardial edema, 

each EM ingredient was tested individually by exposing embryos to either vehicle (0.1% 

DMSO) or 5 μM TPHP. While there were no significant differences in body length or yolk 

sac area across all groups, pericardial area was significantly increased when embryos were 

exposed to TPHP within exposure media containing any of four EM ingredients (Fig. 4). 

Interestingly, the most significant effects were observed when embryos were exposed within 

exposure media containing KCl, CaCl2 · 2H2O, or NaCl, suggesting that chloride may be 

playing a key role in pericardial edema formation.

3.3. D-Mannitol and ionic strength of exposure media do not impact TPHP uptake

Since D-mannitol (an osmotic diuretic) mitigates TPHP-induced pericardial edema and an 

increase in the ionic strength of exposure media exacerbates TPHP-induced pericardial 

edema, we quantified embryonic doses of TPHP and DPHP in the presence of D-mannitol or 

within RO Water vs. 2X EM. Interestingly, embryonic doses of TPHP and DPHP were not 

affected by the presence of D-mannitol nor significantly different within RO Water vs. 2X 

EM (Fig. 5), suggesting that differences in the severity of TPHP-induced pericardial edema 

under these varying experimental conditions were not attributed to differences in TPHP 

uptake.

3.4. TPHP disrupts the morphology and organization of the embryonic yolk sac 
epithelium

Within in Locations C and E, embryos exposed to TPHP within 2X EM exhibited extensive 

microridges relative to embryos exposed to vehicle (Fig. 6). While microridges in TPHP-
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exposed embryos were higher at all locations, we only observed significant differences in 

those two locations. Embryos exposed to TPHP within 2X EM also exhibited extensive 

microridges relative to TPHP-exposed embryos in RO water at Locations C and E (Fig. 6). 

Interestingly, in all but one of the locations, embryos exposed to both TPHP and D-Mannitol 

within 2X EM had significantly less microridges compared to embryos exposed to TPHP 

alone (Fig. 6). Within all five locations, there was also an upward trend in the abundance 

of microridges observed within TPHP-exposed embryos, suggesting that an increase in ionic 

strength of exposure media exacerbated the generation of microridges within embryos.

4. Discussion

Based on our prior studies in developing zebrafish, TPHP is known to increase the number 

of ionocytes, as well as induce pericardial edema, liver enlargement and disrupt cardiac 

looping (Isales et al., 2015; McGee et al., 2013; Mitchell et al., 2018; Reddam et al., 2019; 

Wiegand et al., 2022). Within this study, we found that TPHP-induced pericardial edema 

is dependent on the presence of high ion concentrations within exposure media – a result 

that was likely associated with pericardial edema, increased ionocytes, and decreased body 

length found in our previous studies (Isales et al., 2015; McGee et al., 2013; Mitchell et al., 

2018; Reddam et al., 2019; Wiegand et al., 2022; Yozzo et al., 2013). Numerous studies have 

shown how changing the ion concentration of media can impact embryonic development 

(Liao et al., 2009; Esaki M et al., 2009; Esbaugh et al., 2019). However, to our knowledge, 

little is known about how ionic strength of exposure media directly impacts the toxicity 

of chemicals within zebrafish embryos. Indeed, our findings have significant implications 

due to a lack of standardization of the ionic strength of exposure media within zebrafish 

embryo-based toxicity assays around the world.

To our knowledge, only one other study has investigated the potential impacts of 

contaminants on the skin epithelium of embryonic zebrafish. This study found that metal 

oxide nanoparticles caused skin damage on embryonic zebrafish, specifically cells found 

at the posterior fin and tail fin regions (Peng et al., 2018) but, unlike our study, most 

of the skin damage was localized to the posterior regions. Most studies in the published 

literature have investigated the epithelial layer of adult zebrafish rather than embryonic 

zebrafish. Interestingly, these studies have looked at the capacity for cutaneous wound 

healing within zebrafish (Naomi et al., 2021) and, as such, are difficult to compare to 

our results due to differences in the epithelial layer of adult vs. embryonic zebrafish. For 

example, embryonic zebrafish utilize the entire epithelial layer for osmoregulation due to 

the localization of ionocytes and aquaporins across their skin, while adult zebrafish have 

ionocytes and aquaporins localized to their gills, which occurs around 14 dpf (Breves et al., 

2014; Dymowska et al., 2012; Evans, 2008, 2011; Gilmour, 2012; Hiroi and McCormick, 

2012; Hwang and Lee, 2007; Hwang et al., 2011; Kumai and Perry, 2012; Wright and Wood, 

2012). Embryonic zebrafish also do not develop scales until around 30 dpf (Le Guellec et 

al., 2003), making the embryonic skin more vulnerable to damage that may not impact adult 

zebrafish.

Interestingly, we found that an increase in ionic strength of exposure media exacerbated 

TPHP-induced generation of microridges within embryos. To our knowledge, we are 
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unaware of any other studies in the published literature that have 1) identified the potential 

for chemicals to induce an increase in the abundance of microridges in embryonic zebrafish 

and/or 2) discussed the potential functional role of increased microridges on the yolk sac 

epithelium. Found in many types of freshwater fish species, microridges provide rigidity 

and plasticity to surface epithelial cells; hydration of the apical surface; protection from 

pathogens and physical injury; retention of mucus; and storage of F-actin that can be utilized 

for wound healing (Apodaca and Gallo, 2013; Cone, 2009; Fishelson, 1984; Lam et al., 

2015; Sharma et al., 2005; Sperry and Wassersug, 1976; Uehara et al., 1991). In zebrafish 

embryos, microridges are formed on multiple mucosal epithelial cells and are predominately 

localized on the outer layer of the embryo’s epidermis, where their main purpose is to 

maintain glycans on the skin surface (Inaba et al., 2020). To our knowledge, there is 

little information available on the functional consequences of an increase or decrease in 

microridges. However, it’s possible that an increase in microridges may play a role in wound 

repair and/or prevention of additional injury following exposure to chemicals (e.g., TPHP).

5. Conclusion

To our knowledge, this is the first study to investigate the potential impacts of TPHP on 

the embryonic yolk sac epithelium during early zebrafish development, and how changing 

ion composition of exposure media impacts the toxicity of TPHP within zebrafish embryos. 

Our data suggest that TPHP increases the frequency of microridges on the embryonic yolk 

sac epithelium, leading to potential impacts on osmoregulation during embryogenesis. We 

also found that changing the ionic strength of exposure media influenced the severity of 

pericardial edema formation, with increased ionic strength of the exposure media leading 

to increased pericardial edema. Finally, we demonstrated that D-Mannitol does not impact 

TPHP uptake in embryonic zebrafish while still preventing the formation of TPHP-induced 

pericardial edema.
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Fig. 1. 
Mean (±standard deviation) of the area of CoroNa Green AM fluorescence in the head (A), 

yolk sac (B), trunk (C), total area of the yolk sac (D), and pericardial area (E) of embryos 

exposed to vehicle (0.1% DMSO), 2.5 μM TPHP, 5 μM TPHP or 10 μM TPHP from 24 to 

72 hpf. Asterisk (*) denotes a significant difference (p < 0.05) relative to vehicle controls.

Wiegand et al. Page 15

Environ Int. Author manuscript; available in PMC 2023 March 01.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



Fig. 2. 
Mean (±standard deviation) concentration (in ppm) of fluoride, chloride, nitrite, bromide, 

nitrate, phosphate, sulfate, sodium, calcium, potassium, or magnesium in Reverse Osmosis 

(RO) Water, System Water, 0.5X Embryo Media (EM), 1X EM, and 2X EM. Asterisk (*) 

denotes a significant difference (p < 0.05) relative to RO water.
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Fig. 3. 
Mean (±standard deviation) of length (A), yolk sac area (B) and pericardial area (C) 

of embryos exposed to water control, vehicle (0.1% DMSO), 5 μM TPHP, 250 mM D-

Mannitol, or 5 μM TPHP + 250 mM D-Mannitol in different types of media – Reverse 

Osmosis (RO) Water, 0.5X Embryo Media (EM), 1X EM, or 2X EM. Plus sign (+) denotes 

a significant difference (p < 0.05) relative to 5 μM TPHP in RO water, whereas asterisk 

(*) denotes a significant difference (p < 0.05) relative to embryos exposed to vehicle (0.1% 

DMSO) within the same exposure medium (RO Water, 0.5X EM, 1X EM or 2X EM).
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Fig. 4. 
Mean (±standard deviation) of length (A), yolk sac area (B), and pericardial area (C) 

of embryos exposed to water control, vehicle (0.1% DMSO) or 5 μM TPHP in varying 

exposure media (10.18 mM KCl, 19.73 mM CaCl2·2H2O, 40.71 mM MgSO4, and 294.3 

mM NaCl). Asterisk (*) denotes a significant difference (p < 0.05) relative to vehicle (0.1% 

DMSO) in the same exposure medium (0.17 mM KCl, 0.66 mM CaCl2·2H2O, 0.66 mM 

MgSO4, and 10 mM NaCl), whereas plus sign (+) denotes a significant difference (p < 0.05) 

relative to embryos exposed to 5 μM TPHP in Reverse Osmosis (RO) Water.
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Fig. 5. 
A) Mean (±standard deviation) of measured concentration of DPHP and TPHP (ng/embryo) 

in embryos exposed to vehicle (0.1% DMSO), 5 μM TPHP, 250 mM D-Mannitol, and 5 

μM TPHP + 250 mM D-Mannitol from 24 to 72 hpf. Asterisk (*) denotes a significant 

difference (p < 0.05) relative to vehicle (0.1% DMSO). B) Mean (±standard deviation) of 

measured concentration of DPHP and TPHP (ng/embryo) in embryos exposed to vehicle 

(0.1% DMSO) or 5 μM TPHP in different exposure media – Reverse Osmosis (RO) Water or 

2X Embryo Media (EM). Asterisk (*) denotes a significant difference (p < 0.05) relative to 

vehicle (0.1% DMSO).
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Fig. 6. 
Locations (A, B, C, D, and E) used for SEM on the yolk sac of embryonic zebrafish (A). 

Panels B-F show the total area of microridges across treatment groups within each location. 

(G) Representative images of Location C are shown. Asterisk (*) denotes a significant 

difference (p < 0.05) relative to vehicle (0.1% DMSO) within the same exposure medium. 

Plus sign (+) denotes a significant difference (p < 0.05) relative to 5 μM TPHP in Reverse 

Osmosis (RO) Water. Upside-down T (⊥) denotes a significant difference (p < 0.05) relative 

to 5 μM TPHP in 2X Embryo Media (EM). Within all five locations, there was an increase 

in the abundance of microridges found in TPHP-exposed embryos, suggesting that, in the 

presence of TPHP, an increase in ionic strength of exposure media is associated with the 

formation of microridges within embryos.
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